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n Data Storage and Memory
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. QU=ST (Page no. 11)
1. Digital Versatile or Video Disc (DVD)

[

2. Pen Drive
3. Random Access Memory (RAM)
4. Hard Disk
=X=RCIS=
A. 1. (i) 2. (i) 3. (ii) 4. (i)
B. 1. Volatile 2. Permanent 3. Zettabyte 4. USB

C. 1. Acircular metallic disk covered with a magnetic coating, that is used for storing data, is called
a Magnetic disk.

2. Memory card is used to store data. It is very small in size usually 1-1.5 inches. These are used
in mobile phones and digital cameras.

3. A group of 4 bits is known as a nibble (half a byte). Other units for measuring the computer’s
memory are kilobyte, megabyte, gigabyte, etc.
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5.

Secondary storage devices are categorised into three types:

a. Magnetic Disk: A circular metallic disk covered with a magnetic coating, that is used for
storing data, is called a Magnetic disk. You can record and erase data on a magnetic disk
any number of times.

b. Optical Disc: An optical disc is an electronic data storage medium that can be written to
and read using a low-powered laser beam. The lifespan of an optical disc is longer than
a magnetic disk.

c. Flash Drive: The Flash Drive is a small portable data storage device integrated with a USB
(Universal Serial Bus) connector.

a. We can say that a collection of raw and unorganised facts is known as data.

b. When we organise the data and provide a specific context, it can be called information.

@) FUN_ZON=

1. MEMORY CARD 2. HARD DISK 3. FLASH DRIVE 4. MAGNETIC DISK

Competency-based/Application-based questions

1. We can use memory card to increase our smart phone’s storage space.

2. She can choose pen drive or flash drive for smooth exchange of data.

mlnt_roduction to Excel 2016

LETAS R=CAP (Page no. 14)

Do it yourself.

. QU=ST (Page no. 19)
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2.(d) 3. (e) 4. (a) 5. (b)
=X=RCIS=
(iii) 2. (iii) 3.(i) 4. (iv) 5. (iv)
Name box 2. Title 3. Quick Access 4. Formula 5. Worksheet
T 2.T 3.F 4. F 5. F

The row heading is the grey-coloured number (1,2,3...etc) located in front of each row in the
worksheet.

Ribbon is like a strip that has various tabs such as Home, Insert, Page, Layout, Formulas and
Data.



3. The currently selected cell that appears highlighted with the green border is an active cell.
4. While working in Excel, the following types of data can be entered:

o Numbers: Numbers include the digits (0-9) and their various combinations. All types
of calculations can be done on numbers.

e Text: Text includes the collection of letters, numbers, and special characters. No
mathematical calculation can be performed on text.

5. To enter data, follow the given steps:
Step 1: Click on the cell where you want to enter the data and start typing.
Step 2: To move down one cell, press the Enter key.
Repeat Steps 1 and 2 until you finish entering all your data.

6. Contiguous Cell Range is a collection of cells that are adjacent to or next to one another. A
colon () is used for specifying this cell range, for example, A1:A6.

Non-contiguous Cell Range is a collection of cells that are not adjacent to one another. A
comma (,) is used for specifying this cell range, for example, Al, B2, C3.

7. To create a new workbook in Excel 2016, follow the given steps:
Step 1 Click on File tab.
Step 2 Click on the New option.
Step 3 Click on Blank workbook.

A new workbook will be created.

A. 1.D3 2.D5 3.E4 4.C4 5.B4 6. G4

B. Click on the File tab.
Click on Browse option.
Click on Save or Save As option.

Type a name for your file in the File name box.
@ Click on the Save button.

4 | Select the location where you want to save your workbook.

Competency-based/Application-based questions

1. To save a workbook, follow the given steps:
Step 1: Click on the File tab.
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2.

Step 2: Click on Save or Save As option.

Step 3: Click on Browse option.

Step 4: Select the location where you want to save your workbook.
Step 5: Type a name for your file in the File name box.

Step 6: Click on the Save button.

To fill the time-table, follow the given steps:

Step 1 Click on the cell where you want to enter the data and start typing.

Step 2 To move down one cell, press the Enter key.

Repeat Steps 1 and 2 until you finish entering all your data.

MOn PowerPoint 2016

L=T’'S RECAP (Page no. 26)
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(Page no. 31)

Align Left 2. Align Right 3. Center 4. Justify

(Page no. 39)

Pictures 2. Online Pictures 3. Shapes

=X=ERCIS=
(ii) 2. (iii) 3. (iii)

slide

4. (iii)
2. Design 3. Format 4. Justify
(d) 2.(c) 3.(b) 4. (a)

The Slide Show tab will let you set up how your show will progress.

To insert Online pictures in the document, follow the given steps:
Step 1 Click on the Insert tab.

Step 2 Click on the Online Pictures option.

Step 3 Type a word in Bing Image Search box.

Step 4 Select the picture, you want to insert.

Step 5 Click on the Insert button.

5

4 | Computer Genius (Ver. 2.1)-V (Answer Key)
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4. SmartArt

The four types of alignment are Align Left, Align Right, Center and Justify.
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4. To insert shapes on the slide, follow the given steps:
Step 1 Click on Insert tab.
Step 2 Click on Shapes command in the Illustration group.
Step 3 Choose a desired shape from the drop down menu.

The selected shape will be inserted on the slide.

1. SLIDE 2. PRESENTATION 3. BACKGROUND 4. PLACEHOLDER
5. SMARTART

Competency-based/Application-based questions

1. Rohit can add pictures by using Picture command and Online Pictures command from Insert tab.
He can also use placeholder to insert pictures.

2. She can add themes from the Design tab to make slides look more colourful and attractive.

Periodic Assessment 1
(Based on chapters 1 to 3)

A. 1. Read Only Memory (ROM) 2. Hard Disk 3. Random Access Memory (RAM)
4. Blu-Ray Disc 5. Pen Drive 6. Memory Card
B. 1. Themes 2. Justify 3. Pictures 4. WordArt

5. Placeholder
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LET'S RECAP (Page no. 44)

1. Search information 2. Take a bath

3. Find a recipe ‘ 4. Send an email

5. Download an image 6. Pack your bag

7. Do shopping ‘ 8. Online communication

©. QUEST (Page no. 48)
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Advanced Research Projects Agency
Advanced Research Projects Agency Network
Transmission Control Protocol

Internet Protocol

World Wide Web

Hypertext Transfer Protocol

National Center for Supercomputing Applications

Uniform Resource Locator

=X=RCIS=
1. (i) 2. (i) 3. (iii) 4 (iii) 5.(ii) 6.(ii)
1. Bcc 2.To 3. Cc 4. Attachment 5. Sent
1.F 2. T 3.F 4. F 5. F
1

NUNU

. A Web server is an Internet host computer that often stores thousands of individual Web

pages.

2. Emoticons are used to represent the facial expressions. They help in telling your mood to

others as well as save typing time.

3. Yes, we can send a video file as attachment in an e-mail through “attach files' option.

4. The New Message window has many fields:

« To: In this field, type your friend’s e-mail address. You can enter more than one address

by pressing ’," after each e-mail address.

« Cc: Cc stands for carbon copy. It is marked to the e-mail address who is to be informed

that an e-mail has been sent to the person marked in To field.

. Computer Genius (Ver. 2.1)-V (Answer Key)
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5. Logging In or login is the process of accessing your e-mail account by providing the user
name and password.

6. URL stands for Uniform Resource Locator. It helps us navigate the Web. We can specify a URL
in several ways, but two methods are commonly used:

e Using Address Bar:
Step 1 Type the URL in the browser’s Address bar.
Step 2 Press the Enter key from the keyboard.

e Using Hyperlink:

A hyperlink is simply a part of the Web page that is linked to a URL. A hyperlink can appear
as text, an image, or a navigational tool such as a button or an arrow. You can click a
hyperlink and jump from your present location to the URL specified by the hyperlink.

@) FUN_ZON=

1. Cc 2.To 3. Subject 4. Bcc

Competency-based/Application-based questions

1. By clicking on the Attach files button in the New Message window.

2. Sushant should write Ajay’s e-mail in 'To" and others’ e-mail addresses in ‘Bcc'.

L=T’'S RECAP (Page no. 61)

Do it yourself.

‘. QUSST (Page no. 63)

1. No Parking 2.Veg and Non-Veg 3. Wheelchair 4. Zebra Crossing
5.No U-Turn 6. Hospital
‘% QUSST (Page no. 64)
4%#32
=X=RCIS=

A. 1. (ii) 2. (iii) 3. (iv)
B. 1.T 2.F 3.F

C. 1. Data refers to the raw input. When this data is processed, the outcome received is known as
information.
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2. We can represent information in the following ways:
e in the form of tables, for example, class timetable.
e in the form of pictures, drawing and so on.
e in the form of maps.

e in the form of pictograms, for example, road signs.
A. (i)
B. (iii)

Competency-based/Application-based questions

1. He can sort his things.

2. By using Code data/language.

mCLating Shapes in Scratch

L=T’'S RECAP (Page no. 67)

1. Hat block 2. Stack block 3. Reporter block 4. Boolean block 5. C-block
8. QU=ST (Page no. 71)
1. Heptagon 2. Triangle 3. Pentagon 4. Nonagon 5. Hexagon
6. Octagon
=X=ERCIS=
A. 1. (i) 2. (i) 3.(i)
B. 1. Polygon 2. 360 3.Go 4. Hexagon
C. LF 2.F 3.7 4. T
D. 1. The Pen blocks draw a trail as the Sprite moves on the stage.

2. One of the thumb rule to draw polygons in Scratch is:

« You must know the number of sides in the shape. This is the value to be given in repeat
block. For example, you give repeat 3 to draw a triangle and 4 to draw a square.

3. To add Pen block, follow the given steps:
Step 1: Click on the Add Extension button at the bottom left corner of the Code tab.

5
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Step 2: Click on Pen option. The Pen blocks are added to the Code table.

1. Sides : 0, Degree : 360 2. Sides : 3, Degree : 120
3. Sides : 4, Degree : 90 4. Sides : 4, Degree : 90
5. Sides : 5, Degree : 72 6. Sides : 6, Degree : 60

Competency-based/Application-based questions

1. Pen blocks
2. Repeat 3, Move 100 Steps, Turn 120 degrees

Periodic Assessment 2
(Based on chapters 4 to 6)

A. 1. Itis the folder where all e-mails that you have received from others are stored.
2. Itis the folder where all e-mails that you send to others are stored.
3. Itis the folder where all outgoing e-mails are temporarily stored.
4. 1t is the folder where all unwanted incoming e-mails are stored so that they stays out of the
inbox folder.
5. Ttis the folder where all deleted e-mails are usually stored for a defined time period.
1. Sorting 2. Information 3. Website 4. Coded data 5. Decoding
00
<,
)
-
= Test Sheet 1
(Based on chapters 1 to 6)
A. 1. () 2. (iv) 3. (iii) 4. (ii) 5. (i) 6. (iii) 7. ()
B. 1. Volatile 2. Zettabyte 3. Title 4. Placeholder 5.Cc
C 1T 2.T 3.F 4. F 5F 6.T
D.1.d 2.¢ 3.b 4. a
E. 1. a. Data refers to the raw input.

b. When this data is processed, the outcome received is known as information.

2. While working in Excel, the following types of data can be entered:
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a. Numbers: Numbers include the digits (0-9) and their various combinations. All types of
calculations can be done on numbers.

b. Text: Text includes the collection of letters, numbers, and special characters. No
mathematical calculation can be performed on text.

3. Toinsert Online pictures in the document, follow these steps:
Step 1: Click on the Insert tab.
Step 2: Click on the Online Pictures option.
Step 3: Type a word in Bing Image Search box.
Step 4: Select the picture, you want to insert.
Step 5: Click on the Insert button.
4. E-mail has various advantages, some of them are:
« An e-mail can be sent anytime and from anywhere in the world.
¢ An e-mail can be sent to many people at a time.
« An e-mail can be easily forwarded to anyone without typing it again.
« Sending an e-mail is fast in comparison to traditional mails.
5. We can represent information in the following ways:
a. Inthe form of tables, for example, class timetable.
b. In the form of pictures, drawing and so on.
¢. Inthe form of maps.
d. In the form of pictograms, for example, road signs.
6. To add Pen block, follow the given steps:
Step 1: Click on the Add Extension button at the bottom left corner of the Code tab.
Step 2: Click on Pen option. The Pen blocks are added to the Code tab.

nﬂued Blocks & Game Creation

L=T'S RECAP (Page no. 80)

‘. QUSST (Page no. 83)
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. ask and wait block

. key pressed?

The blocks that end scripts are known as CAP blocks.

. C blocks are loop blocks to check if a condition is true in the blocks within the loop.

QU=ST (Page no. 88)

If a variable is created, to be used and modified by all the sprites, then it is known as a global

variable.
If a variable is created to be used and modified by a single sprite only, then it is known as a local
variable.
=X=RCIS=
1. (iii) 2.(i) 3.(3i) 4. (i)
1. script 2. touching color 3. local 4. ask and wait
1T 2.T 3.F 4. F
1. Scratch blocks can be divided into six types of shapes. They are: Hat, Stack, Boolean, Reporter,

C and Cap.

The sensing blocks in Scratch sense the input from the keyboard or the mouse at the time of
execution of a script.

3. There are two types of variables. They are: Global Variables and Local Variables.

Scratch has two conditional blocks. They are:

« Ifthen block: In this block if the condition is true, the blocks inside conditional block will
run. If the condition is false, the blocks inside conditional block will not run. Only the blocks
outside the conditional block will run.

« Ifthen,.else block: In this block if the condition is true, the blocks inside then condition
will run. If the condition is false, the blocks inside else condition will run.

@) FUN ZON=_

A. 1. The sprite will rotate 360 times. Each time it will turn at 30 degree and move 10 steps.

2. The sprite will turn 15 degrees. It will keep on moving till user stops the program.

B. Do it yourself.

Competency-based/Application-based questions

1. ask and wait block

2. touching mouse-pointer? and say block

>>>>>>>>>>>>>> Computer Genius (Ver. 2.1)-V (Answer Key) 11



A A1 in Popular Apps

L=T’'S RECAP (Page no. 92)

1. Grammarly 2. Duolingo

‘. QUSST (Page no. 96)

1. ChatGPT 2. Google Maps 3. Swiggy 4. Netflix
=X=RCIS=

A. 1. (iii) 2. (ii) 3. (ii) 4. (i)

B. 1.F 2.T 3.T 4.7

C. 1. Swiggy, Ola

2. Netflix uses Al to understand the user’s preferences and suggests content according to the
users’ liking.

@} FUN ZON=

A. 1. YouTube 2. Netflix 3. ChatGPT

Competency-based/Application-based questions

1. Swiggy 2. Google Maps

LET'S RECAP (Page no. 100)
1. Driverless Car 2. Smartphone 3. Smartwatch
‘2. QUEST (Page no. 104)

Do it yourself.

=X=RCIS=
A. 1 () 2. (iii) 3. (i) 4. (i) 5. (ii)
B. 1. Robotics 2. RoboThespian 3. T-HR3 4. Dash & Dot 5. Paro
C. LF 2.T 3.T 4.F
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D. 1. Robots are automatically operated machines that work in place of humans. It is not necessary
that they look like humans by appearance or perform exactly like humans.

2. Robotics is a branch of engineering and science that deals with the design, construction and
functioning of robots.

3. a. Z-Machines b. Nao c. Leka d. RoboThespian e. Robear
1. Sophia 2. Leka 3. Digit 4. RoboThespian 5. Paro 6. Root

Competency-based/Application-based questions

1. Robear
2. Root
Periodic Assessment 3
(Based on chapters 7 to 9)
. 1. C-Blocks 2. Hat Blocks 4. Reporter Blocks
B. 1. Hat blocks always come at the top of a script.
2. A Script is made up of number of blocks.
3. In scratch, a program is called a Script.
C. 1. Swiggy 2. Uber 3. YouTube
. 1. Robear 2. Dash & Dot 3. Z-Machines

mAngles and Value Conversion

L=ET'S RECAP (Page no. 111)

It is a category of colour-coded blocks that we can drag to the Script area.

It is used to reset the scripts on clicking.
It is used to start the code or test it on clicking.

It is used to delete blocks from the Script area.

LA

Blocks are dragged here from the block palette to make code.
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‘2. QUEST (Page no. 119)

1
4.

mo 0O ®m >

{,\

Draw category 2. Conversion category 3. Output category
Input category 5. Variable category 6. Draw category
=X=RCIS=
1. (ii) 2.(0) 3. (i) 4. (i) 5. (iv) 6. (iv)
1. degree 2. right 3. circle 4. Int 5. Input block 6. Boolean
1.7 2.F 3.7 4.T 5.F 6.F
1. b 2.¢ 3.e 4. a 5.d
1. Functions block is used to avoid rewriting same logic/code again and again in a program.
2. Int, Float, String
3. When two lines going in different directions cut each
other at a point, they form an 'Angle’. Angles are
measured in ‘Degrees’ (°).
4. There are many different methods to draw a circle. The easiest way is to use a single motion
block as shown here:
make turtle a dot of radius ()
(e
Select the turtle that is supposed to draw the circle. Enter radius in the space given.
5. To turn a turtle in AI Connect, follow the given steps:
Step 1: Create a new variable ‘T’ from the Variables category. Add set T to block in the script
area.
Step 2: Add create new turtle block, from the Turtles blocks under Draw category, inside the
set T to block.
Step 3: Attach make turtle turn right by block from the Motion block under the Draw category
and enter input angle 90.
Step 4: Click on the Run button.
6. The following are the types of values that we can enter in coding:

&

-
£

Ur

. Integers (Int): Integers are whole numbers that can be positive, negative or O, for example:
1,2,4,0, 67,45, -89, -132 etc.

. Float (float): Floats are numbers that are written with a decimal point in them. For example:
3.4, -432.6,3.14, 0.5, 4.0, etc.

Q)
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. Boolean (bool): Boolean kind of variables have only two values: True or False. We can
verify any kind of statement or condition in a code using a Boolean command.

. String (str): Strings are a sequence of one or multiple characters like alphabets, numbers
or symbols.

“L '@

B. Do it yourself.

Competency-based/Application-based questions

1. make turtle...a dot of radius block

2. input with prompt block

m Math Operators and Loops

L=ET'S RECAP (Page no. 123)
1.c 2.a 3.d 4. b

‘. QUSST (Page no. 127)

1.d 2.a 3. b 4. c
=X=RCIS=
A. 1. (iv) 2. (i) 3. (iv) 4. (ii) 5. (iii)
B. 1. Variables 2. Operators 3. Loops 4. multiplication table
C. 1d 2.a 3.¢c 4.b
D. 1. Repeat command block simply repeats the blocks attached to it for a certain number of times.

Repeat while block also repeats a set of commands in a code but only till a specified condition
is met.

2. Round-up is a math feature majorly used in shopping bills to find the nearest upper value.
Round-down is a math feature mainly used in shopping bills to find the nearest lower value.

3. Math blocks are used to:
+ Calculating total sum

+ Solving math problems

f)
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4. Code to add two numbers, 14 and 21:
Step 1: Add print block, inside it at add Addition block.
Step 2: Write 14 on the one side in the Addition block and 21 on the other side.

@) FUN_ZON= ]

1. It will print the one less number that the user entered 50 times.

2. Tt will print 1 to 10 counting.

Competency-based/Application-based questions

1. 5832 2. For loop 3. Repeat block

BE2 41 in Real world

L=ET’'S RECAP (Page no. 131)

Female, Male

%, QUEST (Page no. 135)

1. F 2.F 3T 4.7

=X=RCIS=
1. (iii) 2. (i) 3. (ii)
B. 1. Some of the features of robots are as follows:
« Robots make complex task easy.

« They never get tired for doing repetitive tasks.
« They can work anywhere.

2. Click onimage icon of Load Image block. Click on Browse button to load image from computer
or click on Capture to capture image using webcam. Click on Submit button after loading an
image.

@) FUN ZON=

In the given code Load Image block is not present.
To correct the code add Load Image block at the top of the code.

To add Load Image block, extend the Al Learning category from the block-palette and select the
Facial Feature sub-category. Then add Load Image block at the top of the code.
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Competency-based/Application-based questions

1. Setting button of if-do block

2. From Al Learning category

Periodic Assessment 4
(Based on chapters 10 to 12)

A.
. 113 2.37
C. 1. Al Learning category 2. Input category 3. Logic category
Test Sheet 1
(Based on chapters 7 to 12)
A. 1. (iii) 2. (i) 3.(i) 4. (i) 5.(3) 6. (i) 7. (i)
B. 1. touching color 2. RoboThespian 3.T-HR3 4. degree 5. Operators
6. Loops
C1lF 2.7 3.T 4.F 5T
.1.d 2.a 3.¢c 4.b
E. 1. There are two types of variables. They are: Global Variables and Local Variables.
2. Netflix uses Al to understand the user’s preferences and suggests content according to the

users’ liking.

3. Robotics is a branch of engineering and science that deals with the design, construction and
functioning of robots.

4. There are many different methods to draw a circle. The easiest way is to use a single motion
block as shown here:

make turtle a dot of radius @

e

Select the turtle that is supposed to draw the circle. Enter radius in the space given.

5. Click onimage icon of Load Image block. Click on Browse button to load image from computer
or click on Capture to capture image using webcam. Click on Submit button after loading an
image.

8.0
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